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BANNER PRESENCEPLUS APPLICATION NOTE 

 
ABSTRACT 
The purpose of this document is to describe the G3’s support for Banner’s 
PresencePlus series of vision systems, and the configuration steps necessary to 
use this feature. 

INTRODUCTION 
Banner is a manufacturer of vision sensors. One of their specialties is vision and 
object recognition. All the PresencePlus series of vision sensors are now 
supported by Red Lion Controls G3 series HMIs. Only graphical color units support 
this feature. 
 
This document will first describe how to configure a G310 HMI to communicate 
and transfer data with a PresencePlus vision sensor, then how the sensor should 
be configured. 
 
This document will step though the procedures to setup the communication for 
the following functions: 
 
• Trigger (Input Flag) 
• Pass Output (Output Flag) 
• Pass Count (Integer value contained in a register) 
• Measurement (Floating Point Number value contained in a register) 
• Tool name (String value contained in a register) 
 
As an example, the PresencePlus P4 OMNI vision sensor will be measuring the 
opening of a Banner Fiber cutter (PFC-2). 
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G3 CONFIGURATION – DISPLAYING THE IMAGE 
Red Lion Controls’ G3 HMIs are programmed using Crimson 2.0 software. This 
software is free and available on the internet at www.redlion.net 
 

 
 
Displaying the camera image on the G3’s display is achieved with the following 
steps: 

a. Activating the Ethernet port, 
b. Setting up the Banner Camera driver, 
c. Inserting the camera primitive on the screen. 

Activating the Ethernet port 

 
The configuration of the Ethernet port is done in the Communication Module. 

1. Click on the word “Ethernet”. This will display the Ethernet settings of the 
HMI. 

2. Change Port Mode: to Manual Configuration. 
3. Change the IP address of the HMI to an appropriate IP address  

(i.e. 192.168.0.10) 
 

 



PAGE 4 

Setting up the Banner Camera driver 

 
The driver for the Banner Camera is configured on one the Ethernet protocols. 

1. Click on Protocol 1 
2. Click Edit to open the driver selection box 
3. Pick the Banner PresencePlus Image driver 

 

 
 
 
Then, configure the camera settings. Multiple cameras can be supported under 
this protocol by clicking Add Additional Device 

4. Click on Cam1 to select the camera 
5. Enter the camera’s IP Address and TCP port 

 

 
 
 

Inserting the camera primitive on the screen  

 
To insert the camera picture on the screen, enter the User Interface module. 

1. Select the Camera primitive in the Drawing box 
2. Click and drag on the screen to insert the primitive 
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3. Double-click the primitive to open the properties 
4. Select the camera that was configure in the Communication module 

 

 
 
The HMI is now ready to receive the Banner Camera images. The image will be 
displayed in the gray area defined by the primitive. If the image is too small, the 
scale property in the camera primitive can be adjusted. 
 
NOTE: The HMI will only display an image if the camera is configured to export 
the image, as shown later in this document. 
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SETTING UP THE G3 – INSPECTION FILE TRANSFER 
This functionality allows the transfer of inspection files from the G3 Compact 
Flash card to the camera memory. Built in functions provide both download and 
upload as well as inspection file selection. 
 
This feature uses the Banner camera driver, therefore the Ethernet port has to be 
setup as shown in the first section of this document; Setting up the G3 – 
Displaying the picture.’ 
 
Refer to the Crimson 2.0 manual for more details on how to run user programs. 
 
NOTE: For the vision sensor to accept product changes from the G3 HMI, the run 
time setting in the camera must be set to hardware input in the Select tab of the 
run screen. Please refer to the section Setting up the camera - Configure the 
vision sensor to accept product changes later in this document for more details. 

Loading files to the Camera 

 
The following function loads the inspection file from the G3 CompactFlash card 
into the camera’s memory. This function can be called in a user program.  
 
*NOTE: The program should be run in the background so the G3 has enough 
time to access the CompactFlash card. 
 
LOADCAMERASETUP(PORT, DEVICE, FILENB, FILENAME) 
 
ARGUMENT TYPE DESCRIPTION 

port int Port number where the Banner camera is connected 

device int Camera device number 

fileNb int Inspection file number in the camera 

fileName cstring Path and filename for the inspection file on the G310 
Compact Flash card 

 
This function returns true if the transfer is successful, false otherwise. 
 
Example: Result = LoadCameraSetup(4, 0, 1, "\\in0.isp"); 
 

Saving files from the Camera 

 
The following function saves the inspection file uploaded from the camera on the 
G3 CompactFlash card. This function can be called in a user program.  
 
*NOTE: The program should be run in the background so the G3 has enough 
time to access the CompactFlash card. 
 
SAVECAMERASETUP(PORT, DEVICE, FILENB, FILENAME) 
 
ARGUMENT TYPE DESCRIPTION 

port int Port number where the Banner camera is connected 

device int Camera device number 
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fileNb int Inspection file number in the camera 

fileName cstring Path and filename for the inspection file on the G310 
Compact Flash card 

 
This function returns true if the transfer is successful, false otherwise. 
 
Example: Result = SaveCameraSetup(4, 0, 1, "\\in0.isp"); 
 

Selecting the inspection file in the camera 

 
The following function will select the inspection file to be used by the camera. 
 
*NOTE: The program should be run in the background to allow the camera 
enough time to change files. 
 
USECAMERASETUP(PORT, DEVICE, FILENB) 
 
ARGUMENT TYPE DESCRIPTION 

port int Port number where the Banner camera is connected 

device int Camera device number 

fileNb int Inspection file number in the camera 

 
This function returns true if the file change is successful, false otherwise. 
 
Example: Result = UseCameraSetup(4, 0, 1); 
 

Program examples for inspection file transfer and selection 

In this example, the G3 has one internal variable named “status” to display the 
status of the upload/download/change process. 

1. Open the tag window 
2. Create an internal string variable called status 

 
There are three basic programs needed for this demo; one to store an inspection 
to the CF, one to load an inspection from to CF, and one to initiate a product 
change. Storing and loading inspections run in the background, the vision sensor 
can processes inspections while transferring inspections.  
Note: A product change must be initiated to run an inspection that has 
been loaded onto the sensor. 
 
This example will store inspections from memory location 1 on the OMNI to the 
CompactFlash card. Program name: “SaveAsInp1”. 
 

Status = “Saving”; 

Sleep(10); 

if ( SaveCameraSetup(4, 0, 1, “\\in1.isp)) 

Status = "Done"; 

else 

Status = "Failed"; 
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This example will load the inspection from the CompactFlash card to memory 
location 1 in the OMNI Vision sensor. Program name: “LoadInp1” 
 

Status = "Loading"; 

Sleep(10): 

if( LoadCameraSetup(4, 0, 1, "\\in1.isp") ) 

Status = "Done"; 

else 

Status = "Failed"; 

This example will initiate a product change by selecting the inspection in memory 
location 1 of the OMNI vision sensor. Program name: “UseInp1” 
 

Status = "Working"; 

Sleep(10); 

if( UseCameraSetup(4, 0, 1) )  

Status = "Done"; 

else 

Status = "Failed"; 

Programs can be executed using a push button or an event action field in the G3. 
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SETTING UP THE G3 – DATA EXCHANGE 
In order to read/write data from the camera, the PresencePlus data driver is 
used. This driver provides access to standard camera information and also user 
defined Modbus registers in the camera. 

Configuring the PresencePLUS data driver. 

 
1. Click on Protocol 2 
2. Edit the Driver Selection 
3. Choose Banner 
4. Choose PresencePLUS Data 

 

 
 

Configure the Device Settings 

 
1. Click on “PLC1” (If desired, rename it to “PresencePLUS”) 
2. Change the IP address to match the Sensor’s IP address (i.e. 192.168.0.1) 

 
Close out the Communications Window 
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Information on Data Tags 

All the standard information available in the PresencePLUS vision sensor can be 
accessed directly with the driver and do not require Modbus mapping. 
 
In this example, the following information can be accessed directly: 

• Trigger (Input Flag) 
• Pass Output (Output Flag) 
• Pass Count (Integer value contained in a register) 

 
However, the following two will be user defined when programming the vision 
sensor: 

• Measurement (Floating Point Number value contained in a register) 
• Tool name (String value contained in a register) 

 
NOTE: In the HMI driver, Input and Output are defined from the 
PresencePLUS Sensor point of view. Therefore, the G3 will write data the 
sensor input and read data from the sensor output. 
 
For more information on how Modbus/TCP registers are organized for the 
PresencePLUS vision sensors, refer to the Appendix.  
 

Configuring Data Tags 

 
Configuring sensor defined tags 
 
Create a Trigger Coil (Flag) Tag 

1. Click on Flag 
2. Click on the newly created Flag variable 

 

 
 

3. Under Mapping, Select PresencePLUS (PLC1) 
4. Choose Input Flags 
5. Select IT – Trigger 
6. Click OK. 
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7. Change Access to Write Only (not shown) 
 

This Tag is finished; click “tags” on the explorer bar window to get back to the 
main tags page. Creating the other tags is very similar. 

 
Create a Pass Output (Flag) Tag 

1. Click “Create a new variable” Flag Button 
2. Select the new variable in the explorer window 
3. Under Mapping select PresencePLUS (PLC1) 
4. Select OP – Pass 
5. Click OK 
6. Change Access to Read Only 

 
Create a Pass Count (Integer) Tag 

1. Click “Create a new variable” Integer Button 
2. Select the new variable explorer window 
3. Under Mapping select PresencePLUS (PLC1) 
4. Choose Output Registers 31xxx 
5. Select O3P – Pass Count 
6. Click OK 
7. Change Access to Read Only 
8. Change Sign mode to Treat as Unsigned 

 
 
Configuring user defined tags 
 
The following tags will be set up in the PresencePlus sensor in the section “Setting 
up the camera”. Tag values will be linked to Modbus register addresses in the 
sensor. The set up will be as follow: 

• Measurement – Register 35 (400033) 
• Tool name – Register 37 (400035) 
 

The generic part of the PresencePLUS data driver has to be used to access these 
registers. 
 
Create a Height Measurement (Real) Tag 

1. Click “Create a new variable” Real Button 
2. Select the new variable explorer window 
3. Under Mapping select PresencePLUS (PLC1) 
4. Choose Modbus Register Address 
5. Enter Element 400033 (shown below) (See Appendix A) 
6. In Data Type choose Word as Long (shown below) 
7. Click OK 
8. Change Access to Read Only 
9. Click on the Format tab 
10. Change the digits after the DP (Decimal Point) to 2 
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Create a Tool Name (String) Tag 

1. Click “Create a new variable” String Button 
2. Select the new variable explorer window 
3. Select the Data tab 
4. Under Mapping select PresencePLUS (PLC1) 
5. Choose Modbus Register Address 
6. Enter Element 400035 (See Appendix A) 
7. Click OK 
8. Choose Encoding: Packed High-to-Low 
9. Choose Access: Read Only 
10. Choose Length: 20 
 

All the necessary tags are created. Close out the Data Tag window and open the 
User Interface window. In the User Interface Window add text to display the tag 
values, and a button for the trigger. 
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SETTING UP THE CAMERA 
 
The PresencePlus vision sensor setup is done in 3 steps: 

a. Configure the System settings 
b. Configure the Inspection 
c. Configure the communication tool 

 
For this example PresencePLUS PC software version 2.7.0 was used with a P4 
OMNI version 1.1.0. Setting up Modbus/TCP is identical for all PresencePlus vision 
sensors. 
 

Configuring the system settings 

 
Click on the “System” button in the upper right hand corner, and the following 
dialog box should appear: 
 

 
 

1. Go to the Communication tab 
2. Choose Industrial Ethernet 
3. Choose the Protocol called “Modbus/TCP” 
4. Leave the 32 Bit format at the default setting “LSW-MSW”. Press the OK 

button to accept this selection. 
 
After the system settings are configured, the Banner vision sensor automatically 
transfers the discrete I/O and inspection Pass / Fail information through the 
Industrial Ethernet. The communication tool data is only needed if you would like 
to send vision tool results, like measurement values, tool names, BLOB Counts, or 
Bar Code strings to the remote device. 
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Configuring the Inspection 

In this example, we will create an inspection measuring the height of the fiber 
cutter using two edge tools, a measure tool, and a test tool. 

 

Configure the vision sensor to accept product changes 

For the vision sensor to accept product changes from the G3 HMI, the run time 
setting must be set to hardware input in the Select tab of the run screen. 
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Configuring the Communication Tool 

After the test tool we add a communication tool to export the measure tool name 
(Height) and the measurement distance (Height). The communication tool is 
configured as the following: 
 

1. Connection(s) is set to Industrial 
Ethernet 

2. Select the measure tool (Height) 

3. Select Distance and Tool Name 
4. View the Register number 

  
Notice that the Register number for the distance measurement is 33 – 34 
(30033). That number is the default number but it can be changed by click on the 
up/down arrows under Register. 
 
Note: Click on the PLC Map to view all the items selected in the communications 
tool. 
 

 
 

The PLC map will display the tool name, the results that will be exported, the data 
type, and the Modbus Register. This map can be saved as a text file on your PC. 
Then save the inspection. 
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Activating image export 

 
Finally, the last step before starting the 
camera is to check Image Enable under 
the Monitor tab so the G3 can display it 
in the primitive. 
The image to be displayed in that 
primitive is defined under the display 
window. Possible choices are available 
such as Next Pass for a continuous 
display or Next Fail to get only failed 
images or any other setting relevant to 
your application. 
 
Click Start to start the camera. 
 
At this point, you can minimize the vision 
sensor software, or close it out entirely. 
 
 
 
 
 
 
 
 
 
This concludes the configuration of the camera. Connect the PresencePLUS P4 
OMNI to the HMI with a crossover Ethernet cable. 
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